
Radio Manager 2.02 Help Contents
Press F1 for help on Help.

Overview Registration  Version History

Radio Setup Configuration Interface Information

Bank Files Opening a File Creating a Bank File

Menu Commands, Buttons, and Controls

Displays

Delays Lock-Outs Priority

Searching History Window

Back Ups OS/2 Notes  Trouble-Shooting Removing



Overview
The R-7000 is a great receiver, but is not so great a scanner.    Fortunately, there is way to 
improve its scanning capabilities.    This is made possible by the remote port on the R-7000, 
an interface cable, a computer, Windows 3.1 or higher, and Radio Manager.    

Now Radio Manager controls the Radio Shack Pro 2005 and Pro 2006 scanners through the 
OptoScan456™.    These are great scanners to begin with, but now with the OptoScan456™ 
and Radio Manager for Windows, you can do even more.

With Radio Manager you can use your computer to store more than the R-7000's ninety-nine 
(99) built-in memories or the Pro 2006's 400.    In fact, you can store up to 998001 channels 
in each Bank File, which will provide ample storage for advanced radio monitors.    Along with
frequencies and modes, you'll also be able to store a description of the frequencies, delays, 
lockouts, priority channels (up to 5), search ranges, and search steps.    You can also choose 
the priority interval and how long a delay should last.    

Radio Manager uses Bank Files to organize frequencies.    You can have as many Bank Files 
as you like, so you can customize your Radio Manager environment according to what you 
want to listen to.    You can lump all of your frequencies into a single Bank File if you want, or 
you might like to have a separate Bank File for several geographical areas, or services that 
you listen to.    

Since Radio Manager takes charge of scanning and searching, you can specify your own 
delay lengths and priority checking intervals, as well as disabling Delays on a channel by 
channel basis.    Any channel within a Bank File can be made a priority channel, and Priority 
checking can be turned on and off.    Any channel can be Locked-out, and like better 
scanner's available a lock-out Review command is available to see what you're missing.

Do you ever get tired of programming in a search range each time you want to search a 
different area?    Radio Manager solves that problem by letting you store as many search 
ranges as you like.    You can store the upper and lower frequencies, mode, direction to 
search and the step size.    What's more when searching if you already have information on a
frequency that is active, Radio Manager can display the information automatically.    This can 
save a trip to a frequency book, so you can skip the frequency and continue your scanning 
adventure.

If you've ever just missed hitting the manual button on a scanner after hearing the tail end 
of an interesting transmission you'll love the History Window.    Radio Manager's History 
Window displays a list of the last 25 or so (it's your choice) active frequencies.    You can then
double-click on any frequency in the list to go back to it. 

Car stereos have preset buttons for our favorite channels, why not scanners?    Radio 
Manager has five (5) buttons you can customize with your favorite channels.    When you 
want to hear one just press the button, and the radio tunes the frequency.    These buttons 
also act as priority channels.

That's a summary of Radio Manager's features.    A sample Bank File is also included, called 
SAMPLE.DB.    Start by setting up the connection between your radio and Radio Manager 
Radio Setup). 

See also
Opening Files, Creating a Bank File, Searching, and Frequency Manager



Displays
Time
Signal
Signal Strength
Status
Bank
Channel
Class
Service

See also
Menu Commands, Buttons, and Controls and Overview



Time Display
Shows current time.    You can use the Configuration Dialog Box to adjust for UTC time.



Signal Display
Radio Manager shows a needle pointing to the right when a signal is detected from the 
radio;    otherwise the needle points to the left.    This display is not always correct, 
depending on the load that your CPU is working.    Radio Manager should still stop on active 
signals, and skip over inactive signals while scanning and searching.

See also
Signal Detection



Status Display
Shows Radio Manager's status and other messages.



Bank Display
Shows a description of the current Bank.



Channel Display
Shows the channel number of the current Bank.



Class Display
Shows the class description of the current channel.



Service Display
Shows the service description of the current channel.



Bank File

If you're using an R-7000, chances are you've used or at least seen how other radios and 
scanners organize memory channels.    Unlike the R-7000, some scanners organize memory 
channels into banks of channels that can be easily enabled or locked-out.    This makes it 
easy to organize your frequencies.    For example, you may have all fire department 
frequencies in one bank, police frequencies in another, aviation in another, and so on.    To 
listen to fire frequencies, just enable the "fire" bank, or if you're not interested in listening to 
fire, lock-out that bank.    Of course, you can have more than one bank enabled or locked out
at a time, so long as one bank is enabled.

Radio Manager Bank Files are "virtual radio memories".    They are similar to the memory in a
scanner with banked memory. They can be separated into as many as 999 banks.    As many 
as 999 channels can be included in each bank.    Ultimately you could have 999 x 999 or 
998001 channels, provided your computer has the memory to hold that many.    Don't worry.  
It's easy to add new channels with Radio Manager.    Since you can have as many Bank Files 
as you like, it's easier to reprogram the R-7000 to the type of listening you happen to be in 
the mood for.    There really isn't any reprogramming of the R-7000's memory since Radio 
Manager takes over responsibility for scanning and searching.    You can however choose 
frequencies from a Bank File, to upload to the R-7000, and use the R-7000 as usual. Of 
course, downloading from the R-7000 is also possible.    Uploading and downloading is not 
available on all radios.    The OptoScan456™    doesn't support uploading and downloading.

Radio Manager stores Bank Files in the Paradox file format.    For more information please see
Paradox Bank File Structure.    Each Bank File has fields for a Bank number, Channel number, 
Frequency, Mode, Class description, Service description, Bank Lock Out, and Channel Lock 
Out.    You can have as many Bank Files as your system has room for.    There can be as many
as 999 banks within each Bank File, and as many as 999 channels within each of those 
banks.

A sample Bank File is included.    See Opening A File to open Sample.DB.

See also
Creating a Bank File



Bank

A collection of channels with the same Bank number.



Channel

A record within a Bank File.    A Bank number (a number from 1 to 999), Channel number* (a 
number from 1 to 999), Frequency (for the R-7000 a number from 25.00 to 999.99), Mode 
(FMN, FMW, AM, or SSB), Class description (example: Fire), and Service description 
(example: Fort Worth F1 Dispatch) within a Bank File.    A single channel or entire bank can 
be enabled or locked-out.    A single channel can also be made a priority channel, which can 
be checked on regular intervals that you can set.    A channel can also be assigned to a Top 5
Button for easy access.

* In this case "channel" refers to a channel number within a bank.    Unlike some scanners 
that have ten banks with 20 channels in each bank (where the second bank starts at channel
21), Radio Manager lets you have any number of channels, from 0 to 999, within a bank.    
What's more, you tell Radio Manager what channel numbers to use.    You could have a 
channel "5" without having a channel "1", "2", "3", and "4".    Thus you can make your 
channel numbers correspond to the channels that the police or fire department is using.



Menu Commands, Buttons, and Controls
Menu Commands for Main Window
File
Open
Save
Save As
Exit

Edit
Bank File
Insert
Delete Channel
Change Description
Run Frequency Manager
Edit Frequency Manager Record
Find
Find Next

Search
Search Range
Look Up Unknowns

Options
Show History Window
Always On Top
Configuration
Radio Setup
Show Channels/Second

OS456
 (This menu only shows up if you've selected OptoScan456™ in the Radio Setup 
Dialog Box.)
Speaker
Computer Control
Tape Recorder
Enable 5KHz Search Windows
Read Signal Strength
Read CTCSS Tone
Read DCS Tone
Read DTMF Digits
Display Status Bits

Help
Contents
How to Use Help
Printable Manual
About

Buttons and Controls
Signal Strength
Frequency Box
Frequency Scrollbar



Mode Box
Enter Button
Look Up Button
Lockout Checkbox
Review Button
Tone Box and Use Tone Box
Delay Checkbox
Bank Delay Checkbox
Channel Scrollbar
Scan Radio Button
Search Radio Button
Manual Radio Button
Go To Button
Priority Checkbox
Bank List box
Top 5 Buttons



Open (File menu)
You can open any existing Bank File, but you can have only one Bank File open at a time.    
Whenever you start Radio Manager, the last Bank File you used is opened.

Dialog Box Options
File Name
Type the name of the file you want to open or choose from the list of files.

List Files of Type
Choose the type of file you want to open from the list of file types.    The file types are 
identified by their file name extensions, for example, Bank Files (.DB), text files (.TXT), or 
All Files (*.*).

Directories
Displays the current directory.    You can choose a different directory.

Drives
Displays the current drive.    You can choose a different drive.

See also
Opening a File



Opening a File
When you start each session with Radio Manager or open the Bank File Dialog Box, the last 
Bank File you used is automatically opened.    

To open a file
1 From the File menu choose Open.

2 In the File Name box, type a name, or choose one from the list of files.

If the file is not listed in the current directory or drive, either type the directory name 
in front of the filename, or choose the correct directory or drive in the Directories box or
the Drives box.

3 Choose the OK button.

See also
Open (File menu-main window) and Open Bank File (File menu - Bank File Dialog Box)



Save (File menu of Radio Manager main window)
Saves the priority channel, Top 5 channels, channel and bank Lock-outs, and channel delays 
in the current Bank File.



Save As (File menu) (Exporting)
Saves the priority, Top 5 channels, channel and bank Lock-outs, and channel delays in the 
current Bank File into a new Bank File.    You'll be prompted to erase the old Bank File.    If 
wish to keep a copy, choose No.

Dialog Box Options
File Name
Type a new filename to save a Bank File with a different name.    Note: A filename can 
contain up to eight characters.    Radio Manager automatically adds the Paradox .DB 
extension to Bank Files.

Save File As Type
The default is the Paradox file format for Radio Manager Bank Files.    You can also type in 
an extension other than .DB, or choose the .TXT extension to export the Bank File to a 
delimited text file.    If you do, you'll be prompted to choose which fields to export.

Directories
Select the directory in which you want to store the Bank File.

Drives
Select the drive in which you want to store the Bank File.

See also
Opening a File



Radio Setup (Options menu)
Opens the Radio Setup Dialog Box for the radio you are using.    You'll be able to customize 
the connection between the radio and your computer, as well as other characteristics of the 
radio you are using.    For information on the physical connection between your computer 
and radio please see the documentation that came with the interface you are using.



Radio Setup - Icom/OS456 Dialog Box
Use this dialog box to change the characteristics of the radio and the connection of the radio
to the computer.    Radio Manager stores your radio's configuration in a file called Icom.INI in 
your Windows directory.    Using this dialog box will insure the correct format is written to the 
Icom.INI file ***.    For information on the physical connection between your computer and 
radio please see the documentation that came with the interface you are using.    The 
Comm. Port, Rate, and Address MUST be set correctly for Radio Manager to control your 
radio.

Dialog Box Options
Comm. Port list box
Choose an available Communications Port.    Note:    You must choose a port that Windows 
recognizes.    Radio Manager uses Windows communications functions to control the radio.  
If you're having trouble getting Radio Manager to communicate with your radio, make sure 
that the same communications port is working by using the Windows Terminal program to 
dial a number with your modem.

Rate (default=1200 for the Icom R-7000)
Choose the data transmission speed (9600 BPS highly recommended) for the connection 
between your computer and radio.    Note: The radio MUST be set to the matching rate for
the connection to work.    For more information consult your radio's manual.    Use the 
highest rate you can.    Radio Manager works best at 9600 BPS, although some really high 
rates may not work.

Address (default=8 for the Icom R-7000) 
Choose the radio's address.    Here are the addresses of some other Icom radios.
Radio Address Radio Address Radio Address
IC-761 1E IC-735 4 IC-1271A/E 24
IC-275A/E/H 10 IC-751A 1C IC-R71A/E/D 1A
IC-475A/E/H 14 IC-751 1C IC-R7100 34
IC-375A 12 IC-271A/E/H 20 IC-R9000 30*
IC-575A/E/H 16 IC-471A/E/H 22 IC-R72 32**
Pro 2005/6 with OptoScan456™ 80

* You will have to change the address on the R-9000 to 30 (on the front panel), and also set 
the address to 30 in Radio Manager.    Preliminary tests on the R-9000 have worked best at 
1200 BPS with the Transceiver switch off.    This information is second hand.    I have not had 
the pleasure of working with the R-9000 myself.    Thanks for sharing your results Phil.
New Information: You might try 2A before the above recommendation.

** You might need to open up the radio to turn on the Record Remote Jack feature.    See 
your Icom manual for details.    Thanks for the info Les!

For more information please consult your radio's manual.

Sample Factor (default=1000)
This number is used for signal detection.    The higher the number the more likely a 
detection will occur.    A lower number will speed up scanning, but you might find that 
scanning does not stop on active channels.    This number is only used for Ring and Carrier 
Detect detection methods.    It is ignored for software detection.

Signal Detection Method (default=0 Hardware - Ring Indicator Pin 22)
Hardware methods are fastest, but if you don't want to make the modifications and you 
have an Icom R72, R7100, or R9000 you'll be able to scan slowly.    If you are using an 



OptoScan456™, choose Hardware - Carrier Detect Pin 8.

OptoScan456 Checkbox (default=unchecked) 
If you are using the OptoScan456™, check this, otherwise uncheck it.

OptoScan456 HW SW
Your OptoScan456's™ Hardware and Software version numbers are displayed. 

Mode Delay (default=1)
If Radio Manager sets the frequency on the radio OK, but not the mode, then try increasing
this number.    

Lowest Channel (default=1 for the Icom R-7000)
You can reserve your radio's memory by choosing a number greater than 1.    Then when 
you write memory channels from a Bank File Radio Manager will prompt you to start at that
number.    You can ignore this field when using the OptoScan456™.

Highest Channel (default=99 for the Icom R-7000)
Radio Manager uses this number to make sure you don't try to write more channels to the 
radio than it has.    If you've modified your radio to have more than 99 channels or you're 
using a radio other than the R-7000, enter the new number of channels.    Since my radio 
stops at channel 99 I have no way of testing this.    If you find it does or does not work 
please let me know. You can ignore this field when using the OptoScan456™.

Lowest Frequency (default=25.0 for the Icom R-7000)
Radio Manager uses this number to verify whether a frequency will work on the radio.

Highest Frequency (default=999.9999 for the Icom R-7000)
Radio Manager uses this number to verify whether a frequency will work on the radio.

Adjust 800MHz
For some reason my R-7000's tuning is off (about 0.0880 MHz low) for frequencies above 
800Mhz, so I built in this adjustment rather than sending the radio off to Icom.    If you have
the same problem, check this box and enter a value in the adjustment box.    

Adjustment
Enter a value to add or subtract to frequencies over 800Mhz so the R-7000 will tune in the 
frequency correctly.    Enter a negative value if the radio tunes too high.    This value is only 
used if you've checked the Adjust 800Mhz box.

Common Setups
If you control more than one kind of radio with Radio Manager, use save your common 
setups so you don't have to reenter each field each time you control a different radio.

Listbox
Shows setups that you've saved.
Use Button
After selecting a setup from the Listbox, choose this button to use the setup.    Radio 
Manager will fill in the information above based on the saved setup, but you must still 
choose OK to
use the setup to control the radio, or Cancel to abort the changes you've made.
Save Name Edit Box 
Type in a name to save the setup as, like "R7000", "R9000", "OS456", etc..
Save Button
After typing a name to save the setup as in the Save Name Edit Box choose this button 
to save the setup.



When you've entered the characteristics you want the radio and connection to have choose 
OK or Cancel if you do not want to accept the changes.    You'll be prompted to restart Radio 
Manager so that the new connection and radio characteristics can be used.

***
If you have two different radios that you want two different configurations files for, you can 
specify an alternate INI file to use by placing the name of the file after "RM.EXE" when 
starting Radio Manager.    For example, a Program Manager icon command line would look 
like this:
RM.EXE MyOwn.INI

The alternate file will also store the settings that are normally stored in the RM.INI file which 
are adjusted using the Configuration Dialog Box.

See also
Radio Setup (Options menu)



Signal Detection
Radio Manager uses the R-7000's Recorder Remote Control output and the Ring Indicator 
(pin 22 on the RS-232 connector) or the Carrier Detect (pin 8 on the RS-232 connector), to 
determine if a signal is present on a frequency.    Instead of telling a recorder to start or stop 
recording, the R-7000 tells Radio Manager if there is or is not a signal.

NOTE: The R-7000's Voice Scan Control (VSC) button MUST be off for Radio Manager to 
detect signals.

For the OptoScan456™ selected Carrier Detect - Pin 8 from the Radio Setup Dialog Box.    No 
modifications are necessary, unless you have one of the original interfaces.

As of version 2.0, Radio Manager now supports Icom's R72, R7100 and R9000, and the 
OptoScan456™ software signal detection which is slower, but better than no signal detection
at all.

See also
Interface Information



Exit (File menu)
Closes Radio Manager and all open Radio Manager files.    You will be prompted to save 
channel lock-outs, bank status, Delays, Priority channel, and Top 5 Buttons.    If you don't like 
being reminded to save the these, you can turn off the reminder in the Configuration Dialog 
Box.



Bank File (Edit menu)
Opens the Bank File Dialog Box for creating and changing Bank Files.



Bank File Dialog Box
Use this dialog box to create and change Bank Files.

Dialog Box Menu Commands
File
New Bank File
Open Bank File
Save Bank File
Save Bank File As
Open Frequency Manager File
Import
Close

Edit
New Bank
Add Trunked System
Find
Find Next

Frequency Manager
Run
Sort by Frequency
Sort by Service
Auto Load File
Hide

Radio
Read from Radio
Write to Radio
Read & Write Delays

Help

Dialog Box Options
Bank List box
Auto Fill Checkbox
New Button
Borrow Button
Delete Button
Bank File Spreadsheet
Frequency Manager Spreadsheet



Add Trunked System (Edit menu - Bank File Dialog Box)
Use this command to quickly add a group of frequencies that are evenly separated.    For 
example, if the City of Arlington has a 5 channel trunked system with frequencies starting 
at 855.4875 and ending at 860.4875 with 1Mhz separating each channel you can quickly 
add all five channels by enter information for the first one and the number of channels in 
the system along with the amount separating each channel.    Just follow the prompts or 
choose Cancel to quit without adding any of the frequencies.



Creating a Bank File
Radio Manager stores its information in Bank Files.    

To create a Bank File

1 Choose Bank File from the Edit menu.

2 Choose New Bank File from the File menu of the Bank File Dialog Box.
Radio Manager clears the Bank File Spreadsheet and creates an empty Bank File.

3 Choose New Bank from the Edit menu of the Bank File Dialog Box.
Radio Manager prompts you for a Bank number and a Bank description.

4 Enter a unique Bank number from 1 to 999. For example, "1".

5 Enter a description for the Bank.    For example, "Fire".
Radio Manager inserts a new channel in the Bank File Spreadsheet.

6 Choose the New Button in the Bank File Dialog Box.
Radio Manager inserts a blank channel in the Bank File Spreadsheet.
If the Auto Fill Checkbox is checked, Radio Manager
automatically fills in the Bank and Channel number for you.

7. Click on the blank channel in the Bank File Spreadsheet and complete the 
information.

Enter a frequency. (From 25.00 to 999.9999Mhz for the Icom R-7000).
Choose a Mode from the Mode List box.
Enter a Class description for the Frequency. For example ("Fire").
Enter a Service description for the Frequency.    For example ('Fort Worth F1 

Dispatch").

Repeat steps 6 and 7 for each channel within a Bank.    When your ready for a new 
Bank

repeat steps 3, 4, and 5. For each channel within the new Bank complete steps 6 and 
7.

8. Save the file by choosing Save Bank File from the File menu of
the Bank File Dialog Box.

Tip: Use Frequency Manager and the Frequency Manager Spreadsheet to speed up 
creating Bank Files.

When you close the Bank File Dialog Box Radio Manager automatically loads the last file you 
worked on.    You're now ready for scanning!

See also
Naming Banks



Naming Banks
Radio Manager's Bank Files are designed to be more descriptive than a conventional 
scanner.    Not only can you describe a channel, you can also describe a bank.    Rather than 
remembering that you have Police frequencies stored in bank number 9, you can label bank 
number 9, "Police".    If you've imported a file to Radio Manager, and need to describe or 
name the banks, or just want to rename some of your existing bank names, keep this in 
mind.

Use the Bank File Dialog Box to name banks.    

Bank descriptions or names are similar to Channels.

Bank descriptions should have the same bank number as the bank you want to describe.
If you're naming bank number 9 then the bank number should be number 9 in the Bank 
column of the Bank File Spreadsheet.

Bank description channel numbers should be "0".
Enter "0" in the Channel number column of the Bank File Spreadsheet.    Bank Files are 
sorted by Bank number, Channel number, and then Frequency, so by making the channel 
number lower than any other channel number in a bank description, it will be listed before 
normal channels with frequencies.    The new order will not show up until you've saved the 
Bank File.

Bank description frequencies should be "0".
Enter "0" in the Frequency column of the Bank File Spreadsheet.

Bank description modes should be "BNK".    
Choose "BNK" from the list box in the Mode column of the Bank File Spreadsheet.

Bank description classes should be filled in with the name of the bank.
Type in the description in the Class column of the Bank File Spreadsheet.

Bank description services can be left blank.

See also
Creating a Bank File and New Button



New Bank File (File menu - Bank File Dialog Box)
Use this command to create a new Bank File.

See also
Creating a Bank File



Open Bank File (File menu - Bank File Dialog Box)
You can open any existing Bank File, but you can have only one Bank File open at a time.    
Whenever you open the Bank File Dialog Box, the last Bank File you used in Radio Manager is
opened.

Dialog Box Options
File Name
Type the name of the file you want to open or choose from the list of files.

List Files of Type
Choose the type of file you want to open from the list of file types.    The file types are 
identified by their file name extensions, for example, Radio Manager files (.DB), text files 
(.TXT), or All Files (*.*).

Directories
Displays the current directory.    You can choose a different directory.

Drives
Displays the current drive.    You can choose a different drive.

See also
Creating A Bank File and Opening a Bank File



Save Bank File (File menu - Bank File Dialog Box)
Use this command to save the current Bank File.    Radio Manager saves the information that 
you've entered in the Bank File Spreadsheet.    

See also
Save Bank File As (File menu - Bank Dialog Box)



Save Bank File As (File menu - Bank File Dialog Box)
Use this command to save the current Bank File.    Radio Manager saves the information that 
you've entered in the Bank File Spreadsheet.    You'll be prompted to erase the old Bank File.   
If you wish to keep a copy, chose No.

Dialog Box Options
File Name
Type a new filename to save a Bank File with a different name.    Note: A filename can 
contain up to eight characters.    Radio Manager automatically ads the Paradox .DB 
extension to Bank Files.

Save File As Type
Currently only the Paradox file format is supported in Radio Manager, so you do not need 
to change this setting.

Directories
Select the directory in which you want to store the Bank File.

Drives
Select the drive in which you want to store the Bank File.

See also
Save Bank File (File menu - Bank File Dialog Box)



Open Frequency Manager File (File menu - Bank File Dialog Box)
Use this command to load a Frequency Manager file into the Frequency Manager 
Spreadsheet.

Dialog Box Options
File Name
Type the name of the file you want to open or choose from the list of files.

List Files of Type
Choose the type of file you want to open from the list of file types.    The file types are 
identified by their file name extensions, for example, Radio Manager and Frequency 
Manager files (.DB), text files (.TXT), or All Files (*.*).

Directories
Displays the current directory.    You can choose a different directory.

Drives
Displays the current drive.    You can choose a different drive.



Close (File menu - Bank File Dialog Box
Use this command to quit editing Bank Files and return to the Radio Manager main window.
You will be prompted to save changes to the current Bank File.



New Bank (Edit menu - Bank File Dialog Box)
Use this command to create a new Bank in the Bank File Spreadsheet

Radio Manager prompts you for a Bank number and a description of the Bank.
Enter a number from 1 to 999 and a description.    For example, "Fire" or "Police".

Radio Manager inserts a new Bank in the Bank File Spreadsheet.

See also
Creating a Bank File and New Button



Find (Edit menu - Bank File Dialog Box)
Use this command to open the Find Dialog Box.



Find Dialog Box (Bank File Dialog Box)
Use this dialog box to search for text in either the Bank File Spreadsheet or the Frequency 
Manager.    Radio Manager then shows the text if found.

Dialog Box Options
Text to Look for box
Type the text you want to find, or paste it from the Clipboard (CTRL+INSERT).

Where?
Choose the field you want to search, Class, Service, or Frequency.

Which Spreadsheet?
Choose the spreadsheet you want to search, Bank File or Frequency Manager.

See also
Find (Edit menu - Bank File Dialog Box) and Find Next (Edit menu - Bank File Dialog Box)



Find Next (Edit menu - Bank File Dialog Box)
Finds and shows the next occurrence of the specified text in the Find Dialog Box.

See also
Find (Edit menu - Bank File Dialog Box) 



Run (Frequency Manager menu - Bank File Dialog Box)
Starts Frequency Manager.



Sort by Frequency (Frequency Manager menu - Bank File Dialog 
Box)
Check this option to sort the information in the Frequency Manager Spreadsheet by 
frequency.

Uncheck to sort by Class, Service, and then Frequency.    

See also
Sort by Service



Sort by Service (Frequency Manager menu - Bank File Dialog Box)
Check this option to sort the information in the Frequency Manager Spreadsheet by service.

Uncheck to sort by Class, Service, and then Frequency.    

See also
Sort by Frequency



Auto Load File (Frequency Manager menu - Bank File Dialog Box)

If you want Radio Manager to automatically load the Frequency Manager Spreadsheet with 
the last Frequency Manager file that you worked with, check this option.    Uncheck it to 
disable automatically loading the file.



Hide (Frequency Manager menu - Bank File Dialog Box)
Use this command to Hide the Frequency Manager Spreadsheet.    This will let the Bank File 
Spreadsheet expand, so you can view and edit more channels in the Bank File. 

To show the Frequency Manager Spreadsheet just choose Hide again. 



Read from Radio (Radio menu - Bank File Dialog Box)
Use command to read your radio's built memories into the Bank File Spreadsheet, where 
they can be made part of a Bank File.

The Icom R-7000 has at least 99 built in memories, you may have added more.    
Programming these by hand takes quite some time.    It would be nice not to have to enter 
those again.    Radio Manager can save those memories into a Bank File, so you can easily 
switch the radio's memories without worrying about having to reprogram the radio by hand.  

To Read your radio's memories into a Bank File do this

1 Click the mouse cursor on a bank in the Bank File Spreadsheet where you want Radio 
Manager to put the radio memories.    You can use the Bank List Box, to choose a 

bank from available banks, or choose New Bank to create a bank especially for the radio 
memories.

2 Choose Read from Radio in the Radio menu of the Bank File Dialog Box.
You will be prompted for the first and last radio memory channels to read from.

3 Enter the first memory channel in the radio you want to read from.

4 Enter the last memory channel in the radio you want to read from.

Radio Manager reads memories from the radio into the Bank File where you specified.

Note:    If you find that the memories have not been read correctly or completely, you'll 
need to increase the Read Delay.

See also
Read & Write Delays



Write to Radio (Radio menu - Bank File Dialog Box)
Use this command to write Bank File channels to the radio's built in memories.

The Icom R-7000 has at least 99 built in memories, you may have added more.    
Programming these by hand takes quite some time.    Radio Manager can speed things up for
you.    

To Write Bank File channels to your radio's memories do this

1 Select a block of channels in the Bank File Spreadsheet.

2 Choose Write to Radio from the Radio menu in the Bank File Dialog Box.
You will be prompted for the first radio memory channel to write to.

3 Enter the first memory channel in the radio you want to write to.
Radio Manager writes the selected channels to the radio.

Note:    If you find that the memories have not been written correctly you'll need to increase 
the Write Delay.

See also
Read & Write Delays



Read & Write Delays (Radio menu - Bank File Dialog Box)
Use this command to open the Read & Write Delays Dialog Box.



Read & Write Delays Dialog Box
Due to the higher speed of your computer and the lower speed of the connection between 
your computer and radio, a delay may be necessary to Read and Write your radio's built in 
memories.    

Smaller numbers decrease the amount of time it takes to read or write memories, but if too 
small, not all channels will be read or written.    If Radio Manager doesn't read or write all of 
the channels you specified, try increasing the appropriate delay.    If may be quicker to try a 
smaller range of channels (may be 15 channels instead of all 99 the R-7000 supports) until 
you've found the delay that works best for your system.    Read and Write Delays of 7 and 5 
respectively seem to work best on my 486 DX2 66Mhz.

Dialog Box Options
Read Delay and Write Delay Spin Controls
Enter a number from 1 to 99, or use the spin control to increase or decrease the displayed 
amount by one (1).

See also
Read from Radio and Write to Radio



Help (Help menu - Bank File Dialog Box)
Opens Help with information relevant to the Bank File Dialog Box.



Bank List box (Bank File Dialog Box)
Lists the Banks in the current Bank File.

Choose a Bank from the list and Radio Manager will display that bank in the Bank File 
Spreadsheet. This is especially handy when you have several banks in a Bank File and you 
want to move to another Bank. 



Auto Fill Checkbox (Bank File Dialog Box)
When checked, Radio Manager automatically fills in the Bank and Channel numbers for 
Banks and channels created with New Bank (Edit menu - Bank File Dialog Box) and the New 
Button.    Radio Manager takes the Bank number from the currently selected bank in the 
Bank File Spreadsheet and calculates the next available channel number.

When unchecked, you'll need to manually enter the bank and channel number.

See also
Creating a Bank File



New Button (Bank File Dialog Box)
Inserts a blank channel in the Bank File Spreadsheet.

See also
Auto Fill Checkbox and Creating a Bank File



Borrow Button (Bank File Dialog Box)
Inserts information from the rows selected in the Frequency Manager Spreadsheet into the 
Bank File Spreadsheet.    

When a single Frequency Manager Spreadsheet row is selected the information is placed 
into the current row of the Bank File Spreadsheet.

When more than one Frequency Manager Spreadsheet row is selected the information is 
inserted into new rows in the Bank File Spreadsheet.

Tip: Double-click on a Frequency Manager row and Radio Manager automatically inserts a 
new channel into the Bank File Spreadsheet with information from the row you clicked on.

See also
Auto Fill Checkbox 



Select
To mark a row or a group of rows in a spreadsheet for further action.    Selected rows appear 
highlighted.    To select a row, click on the row number with the left mouse button.    To select 
several rows click on the first row you want selected (continue to hold the left button down) 
and drag the mouse to the last row you want selected, then release the mouse.



Delete Button (Bank File Dialog Box)
Deletes the selected rows in the Bank File Spreadsheet.    Depending on your setup you may 
or may not be prompted to confirm the deletion.    Deleted rows cannot be recovered.

See also
Configuration Dialog Box



Bank File Spreadsheet (Bank File Dialog Box)
This control displays the current Bank File.    Use it to create and change Bank Files.    Each 
channel in the Bank File is a row in the spreadsheet.

Columns
Bank
A number from 1 to 999.
For Top 5 Buttons the Bank number that you want associated with the button.

Channel
A number from 1 to 999.    
For channels that describe a Bank use "0".    Radio Manager uses the first channel in a Bank
to describe the Bank.
For Top 5 Buttons the channel number that you want associated with the button.

Frequency
A frequency (from 25.00 to 999.9999 MHz for the Icom R-7000)
For channels that describe a Bank enter "0.0".
For channels that describe a Top 5 Button, enter the number of the button times -1.    For 
example, the third Top 5 Button would have a frequency of -3 and the fifth's would be -5.

Mode
Radio Manager Mode Icom Mode
FMN FMN
FMW FM
AM AM
SSB SSB
LSB LSB
USB USB
CW CW
FSK RTTY
FM1 FM Passband Width 1
FM3 FM Passband Width 3
FM9 FMW on R-9000

BNK for channels that describe a bank.
PR1, PR2, PR3, PR4, or PR5 for channels describing Top 5 Buttons.

Class
A description of the frequency's class.
For channels describing banks, a description of the entire bank.
For channels describing Top 5 Buttons, a label for the button. Only 12 characters will be 
displayed.

Service
A description of the organization using the frequency.

See also
Opening a Bank File, Frequency Manager Spreadsheet and Creating a Bank File.



Frequency Manager Spreadsheet (Bank File Dialog Box)
This control displays the current Frequency Manager file if any.    You can easily copy 
information from the Frequency Manager Spreadsheet into the Bank File Spreadsheet to 
quickly create Bank Files.    Each row in the spreadsheet is a record in a Frequency Manager 
file.

Columns
Class
A grouping of frequencies.    For example, Fire, Police, EMS, Aviation.

Service
A description of who is using the frequency.    For example, "Fort Worth F1 - Dispatch".

Frequency
A frequency.

Mode
A mode, usually FMN, FMW, AM, or SSB.

You cannot create or change Frequency Manager files in Radio Manager, but you can use the
data to simplify creating Bank Files.    

See also
Borrow Button



Frequency Manager (Edit menu)

Starts Frequency Manager.    



Frequency Manager
Frequency Manager is a separate database program from Radio Manager designed to help 
organize and manage radio frequencies that amateur radio operators and scanner 
enthusiast use.    With Frequency Manager you can store, sort, print, and search for 
frequencies.

You can use information from the Frequency Manager files to create Bank Files within the 
Bank File Dialog Box.    You can also use the Look Up Button to get information from 
Frequency Manager files to display within Radio Manager.

Frequency Manager has its own independent help system.    To use it start Frequency 
Manager and choose Help.    You can also open the Frequency Manager help file by choosing 
the FM.HLP from the File Open Dialog Box of Help.

See Also 
Frequency Manager Help (FM.HLP)



Find (Edit menu - main window)
Use this command to search for text within a Bank File.    Enter the text to look for, and Radio
Manager will look in the Class and Service fields of the current Bank File's channels.

See also
Find Next



Find Next (Edit menu - main window)
Use this command to search for the next occurrence of text within a Bank File.

See also
Find



Show History Window (Options menu)
Displays the History Window when checked.    Hides the History Window when unchecked.    



History Window
This window shows the last X active frequencies where X is a number    from 1 to 999.    You 
can specify X in the Configuration Dialog Box.    The window shows the frequency, the time 
the frequency became active, active DCS and CTCSS squelch tones if you are using the 
OptoScan456™, and the class and service if known.    You can double-click on any frequency 
in the History Window and the radio will switch to that frequency.    This can be handy for 
returning to a transmission that you may have skipped over inadvertently.    You can clear 
the History Window to get a fresh start by choosing CLEAR from its control menu located at 
the top left corner of the History Window.    You can hide the window by choosing HIDE from 
the same control menu, or from the Options menu on Radio Manager's main window.    The 
History Window still tracks frequencies even when hidden.    Choose SAVE from the control 
menu, and Radio Manager will save the frequencies and some of the other information in the
History Window into a file called RMLOG.TXT in the current directory (This is a new and 
different file name in version 2.02).    You can then manipulate the file for further analysis 
with another program or to add it to frequency lists.    Radio Manager remembers the 
position and size of the History Window from the last time that you ran Radio Manager, and 
displays it in the same position and size.    Just resize or move the History Window to your 
preferred place and size, and Radio Manager will do the rest.

See also
Show History Window



Search (Options menu)
Opens the Search Dialog Box.



Search Dialog Box
Use this dialog box to create, change, and choose search ranges.    You can also choose one 
by double-clicking on the description to start searching.    Radio Manager will display which 
range you chose in the status line as the search begins.

Dialog Box Options
Description
Lists descriptions of the search ranges that already exist.

New
Choose to create a new search range.

Rename
Choose to change the description of an existing search range.

Delete
Choose to remove a search range.

Upper
Enter the upper frequency limit for the selected range.

Lower
Enter the lower frequency limit for the selected range.

Mode
Enter the mode for the selected range.

Step
Enter, or choose from the list, the step size for the selected range.

Delay
Check to enable delay for the selected range, or uncheck to disable delay.

Up
Choose to search by increasing frequency from lower limit to upper limit.

Down
Choose to search by decreasing frequency from upper limit to lower limit.

See also
Searching and Frequency Scrollbar



Search Range

In Radio Manager, an upper and lower frequency limit, a mode, a step size, a delay, and a 
description of the range.    Use the Search Dialog Box to create, change, and choose search 
ranges.    You can have as many as you like.    Several are already entered for you.    Radio 
Manager remembers the search range from the previous time that you ran Radio Manager.

Example
Description: Aviation
Upper Limit 136.0000
Lower Limit 108.0000
Mode AM
Step Size 0.0125
Delay Yes



Step Size

The amount that a frequency increases or decreases within a search or when using the 
Frequency Scrollbar.



Look Up Unknowns (Options menu)
When checked and in search mode, automatically looks up active frequencies in the last 
Frequency Manager file used.



Always On Top (Options menu)
When Radio Manager is iconized causes the Radio Manager icon to appear on top of other 
windows. This makes it easy to get back to Radio Manager while you're in another program.   
Also when you minimize Radio Manager, the frequency that is being scanned is shown in the
window title, so if you've checked this option you'll be able to see what frequency the radio 
is tuned to.    Radio Manager remembers whether or not you want it to be Always On Top, so 
you don't have to choose it every time you start Radio Manager.

Note: If there are other windows, like Help, that are also Always On Top, this option may not 
be as useful.

See also
Control Menu Commands
 



Configuration (Options menu)
Opens the Configuration Dialog Box.



Configuration Dialog Box
Use this dialog box to customize Radio Manager for you.    Change items as needed and 
choose OK to save changes or Cancel to discard changes.    When you choose OK, Radio 
Manager saves the changes so that future sessions will use the new settings.    Radio 
Manager stores these settings in a file called RM.INI in your Windows Directory.    Use this 
dialog box to insure the RM.INI file is formatted correctly. ***

Dialog Box Options
Delay Amount (in seconds)
Choose a delay amount from the list or type in your own.

Snooze Lock Out (in seconds)
Choose an amount of time that you want a channel to be locked out when you Right-Click 
on the Lock Out Checkbox, as opposed to a Left-Click which stays locked out, until you 
Left-Click again.    Snooze Lock Outs are automatically unlocked out after the amount of 
time has elapsed that you specify here.

Small Step
Choose a small step size from the list or type in your own.
This number is used by the Frequency Scrollbar.

Large Step
Choose a large step size from the list or type in your own.
This number is used by the Frequency Scrollbar

History Limit
Enter the number that you want the History Window to limit its detail records to.    When 
the History Window reaches that limit, the oldest history record will be deleted to make 
room for the most recent event.

UTC Adjustment
If you want Radio Manager to display Universal Coordinated Time (UTC) instead of local 
time, enter a number other than 0.

Create Paradox 4.0 files
Check to create Paradox 4.0 version files. Uncheck for version 3.5 files.

Speed Factor
Enter a number larger than 20.    Radio Manager uses this number to determine how often 
to change channels when scanning or how often to increase or decrease the frequency 
when searching.    A smaller number will speed up scanning, however if you're running 
several other applications it may slow their response down.    A higher number will slow 
scanning, but give more time to other applications to complete their tasks.    I find that 60 
works well for my 80486 DX2 66MHz machine.    Please let me know what number what 
works best for you.

Prompt for Saves
Check if you want Radio Manager to remind you to save files before certain actions.

Confirm Deletes
Check if you want Radio Manager to confirm deletion of rows in the Bank File Dialog Box.

Priority Interval (in seconds)
Choose a priority interval from the list or type in your own.



Priority On after Loading
Check if you want Radio Manager to turn on priority checking after loading a Bank File.

RM.INI File
In addition to the settings above you can use a text editor, like Window's NotePad.EXE, to 
change these settings in the RM.INI file located in your Windows directory.

Setting Example
Search Path=D:\RM\
where Radio Manager should look for the search range file SEARCH.DB.

Frequency Manager Path=D:\BP\FM\
The path where Radio Manager can find Frequency Manager.

DelayAmounts=1, 2, 3, 5, 10
These will be listed in the Delay Amount Dialog Box and Configuration Dialog Box.

Priority Intervals=1, 2, 3, 5, 10
These will be listed in the Priority Interval Dialog Box and Configuration Dialog Box.

Step Sizes=0.0250, 0.0500, 0.0125, 1.00
These will be listed in the Step Sizes Dialog Box and Configuration Dialog Box.

Beep on Priority Channel=1 ( 0 = Do not Beep, 1 or more = Beep)
When the priority channel becomes active Radio Manager will beep alert you.
If you have Windows 3.1 and can play wave files you can have Radio Manager play the 
system sounds you've defined in the Windows Control Panel Sound applet.    See Control 
Panel Help for more information on Windows sounds.

Delay On=1
When set to 1 Radio Manager will automatically turn Delay on for new channels that you 
create. When set to 0 Radio Manager will automatically turn off Delays for new channels that
you create.

To play the wave file associated with Enter
Default Beep 1
Critical Stop 16
Question 32
Exclamation 48
Asterisk 64

***
If you have two different radios that you want two different configurations files for, you can 
specify an alternate INI file to use by placing the name of the file after "RM.EXE" when 
starting Radio Manager.    For example, a Program Manager icon command line would look 
like this:
RM.EXE MyOwn.INI

The alternate file will also store the settings that are normally stored in the ICOM.INI file 
which are adjusted using the Radio Setup Dialog Box.

See also
Configuration (Options menu)





Contents (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can
jump to Overview and other information.

Once you open Help, you can click the first button on the left in the Help window whenever 
you want to return to the opening screen.



How to Use Help (Help menu)
Use this command to learn how to use help.



About (Help menu)
Use this command to display the version number of your copy of Radio Manager, the 
copyright notice, Windows operating mode, free memory, and free system resources.



Enter Button
Use this command to change the radio to the frequency and mode displayed in the 
Frequency and Mode boxes.    If the frequency is stored in a channel in the current Bank File, 
then Radio Manager will display the information from the channel. 

Note:    This button does NOT store the frequency in memory like a scanner.    To store 
frequencies in memory you must create a Bank File.

See also
Creating a Bank File



Frequency Scrollbar
In Manual Mode
Increases or Decreases the displayed frequency by a small or large step.    If you've 
searched, the small step size will be changed to match the search ranges step size.

Doing This Does this
Up Arrow (click with mouse or press UP ARROW) Increases by small step
Down Arrow (click with mouse or press DOWN ARROW) Decreases by small step
Page Up (press PAGE UP on keyboard) Increases by large step
Page Down (press PAGE DOWN on keyboard) Decreases by large step

If the new frequency is stored in a channel in the current Bank File, then Radio Manager will 
display the information from the channel.

To change the small and large step sizes for the current session only
Click on the Frequency Scrollbar with the Right mouse button to adjust the small and large 
step sizes.    

To change the small and large step sizes for the current and future sessions
Use the Configuration Dialog Box. 

In Search Mode
Changes the search direction or starts search from Upper or Lower Limit.

Doing This Does this
Up Arrow (click with mouse or press UP ARROW) Changes search direction to Up
Down Arrow (click with mouse or press DOWN ARROW) Changes search direction to Down
Page Up (press PAGE UP on keyboard) Starts search over from Lower Limit
Page Down (press PAGE DOWN on keyboard) Starts search over from Upper Limit

In Scan Mode
Changes the scan direction.    Click on the up arrow to scan normally, channel 1, 2, 3, etc. or 
click on the down arrow to scan backwards, channel 3, 2, 1, etc.    Radio Manager remembers
which direction you were scanning from the last time that you ran Radio Manager, and starts
scanning in that direction.

Doing This
Up Arrow (click with mouse or press UP ARROW) Changes scan direction to Up
Down Arrow (click with mouse or press DOWN ARROW) Changes scan direction to Down



Step Size Dialog Box
Use this dialog box to change the small and large step sizes that the Frequency Scrollbar 
uses when increasing and decreasing frequencies.    

Dialog Box Options
Small Step
Choose a small step from the list or type in your own.

Large Step
Choose a large step from the list or type in your own.

Both small and large step sizes can be any number from 0.0001 to 999.9999.    Setting these
sizes with this dialog box will only affect the current session of Radio Manager.    To make the 
changes permanent, set the sizes in the Configuration Dialog Box. 



Look Up Button
Use this command to display information on the frequency displayed in the Frequency Box.    
Radio Manager looks for the frequency's Class and Service in the last Frequency Manager file
used.    You can press the Look Up Button again to see if there is more than one record for 
the frequency.    For example, if 453.275 is used by more than one city, you can press the 
Look Up Button as many times as you need to show the information on each city.



Lock Out Checkbox
Check (Left-Click) this box when you want to skip over the displayed channel.    Uncheck the 
box to scan the channel.    To save lock-outs choose Save from the File menu.    You must be 
in manual mode to unlock channels.

Right-Click on this box to temporarily lock out the channel while scanning.    When the 
Snooze Lock Out expires, the channel will automatically be Unlocked Out, and included in 
the scanning sequence again.    This is handy if you want to scan a particular channel, but 
don't want to hear the current conversation, or there is some interference that only lasts for 
a short while.

See also
Configuration Dialog Box, Review Button    and Save 



Review Button
Use the this button to display channels that are currently locked out.    You can press it 
repeatedly to cycle through locked out channels.    Note: Only channels that are locked out 
in enabled banks will be displayed.    If you have a bank called "Fire" and it is not enabled, 
then channels that are locked out within "Fire" will not be displayed.

See also
Lock Out Button and Bank List box



Delay Checkbox
Check this box to enable delays for the current channel.    Uncheck it to disable delays for 
the current channel. Note: Radio Manager must be in manual mode to change the delay 
status for a channel.    You can use the Channel Scrollbar to move to different channels.

Click on the Delay Checkbox with the Right mouse button to adjust the delay length, or use 
the Configuration Dialog Box.    

To save which banks have delays choose Save from the File menu.

See also
Save and Bank Delay Checkbox



Delay

An amount of time that Radio Manager waits before proceeding to the next channel or 
frequency after there is no signal detected on the current channel or frequency.    This should
be a number from 0 to 999.    This may not necessarily be the number of seconds, but will be
fairly close.    Several delay amounts are listed for you to choose, or you can type in your 
own.

Tip:    Click on the Delay Checkbox with the Right mouse button to quickly change the delay 
amount.    This method does not save the number each time, so it's quicker.    When you've 
found a number that works for you use the Configuration Dialog Box to make the change 
permanent.

See also
Delay Checkbox and Bank Delay Checkbox



Channel Scrollbar
Use this to move to different channels and banks within the current Bank File.    As you move 
the scroller Radio Manager displays the corresponding channel.

While scanning, clicking on the left arrow changes the scan direction to reverse, and 
clicking on the right arrow changes the scan direction to normal direction.

 Mouse

To move Do this 
_____________________________________________________________ 
To next channel Click on Right Scroll Arrow 
To previous channel Click on Left Scroll Arrow
To last channel Click and Drag Scroll Box to the far right
To first channel Click and Drag Scroll Box to the far left
Ten channels forward Click between Scroll Box and Right Scroll Arrow
Ten channels back Click between Scroll Box and Left Scroll Arrow 

 
Keyboard

Begin by pressing ALT + P.

To move  Press
_____________________________________________________________ 
To next channel RIGHT ARROW or DOWN ARROW
To previous channel LEFT ARROW or UP ARROW
To last channel END
To first channel HOME
Ten channels forward PAGE DOWN
Ten channels back  PAGE UP



Scroll Bar

A bar that appears in the lower center of the main window or on a list box.    Each scroll bar 
contains two scroll arrows and a scroll box, which you click to scroll within the window or list 
box.



Scroll Arrows

An arrow at either end of a scroll bar that is used to move the contents of the window or list 
box.



Scroll Box

A box in a scroll bar -- The scroll box shows the position of what's currently in the window or 
list box relative to the contents of the entire window or list box.



Bank List box
This list box shows the individual banks within the current Bank File.    Highlighted banks will 
be scanned.    The others will not.    To enable a bank simply click on it with the mouse or use 
the arrow keys to move to the bank you want to enable or disable, and then press SPACE 
BAR to change the status.

You can click on the Bank List box with the Right mouse button to select or deselect All 
banks.

To save which banks are enabled and locked-out choose Save from the File menu.

See also
Save



Scan Radio Button
Use this button to change to scan mode or to continue scanning past the current channel.    
You can also click on the Radio Manager main window title bar with the Right mouse button 
to instead of the Scan Radio Button.

See also
Search Radio Button and Manual Radio Button



Search Radio Button
Use this button to change to search mode or to continue searching past the current 
frequency.    You can also click on the Radio Manager main window title bar with the Right 
mouse button to continue searching.    

You can also click on the Search button with the Right mouse button to open the Search 
Dialog Box or start a direct search.

See also
Scan Radio Button and Manual Radio Button



Direct Search

A search that begins at the current frequency and has an upper limit equal to the highest 
frequency that the radio can tune, and a lower limit equal to the lowest frequency the radio 
can tune.    Radio Manager determines changes the best step size depending on the 
frequency range being searched.

See also
Searching



Manual Radio Button
Use this button to change to manual mode and stop scanning or searching.    You can then 
enter frequencies by hand into the Frequency Box or with the Frequency Scrollbar.    You can 
also double-click on the Radio Manager main window title bar with the Right mouse button 
to switch to manual mode.

See also
Scan Radio Button and Search Radio Button



Go To Button
Opens the Channel Finder Dialog Box for finding channels.    If you know the frequency you 
want to go to simply enter it in the Frequency Box and choose the Enter Button.    Otherwise, 
you can use the Channel Finder Dialog Box to find the frequency, and the Go To Button will 
set the frequency for you.



Channel Finder Dialog Box
Use this dialog box for finding channels within a Bank File.    You can then go to that 
channel( if you chose the Go To Button), or associate the channel with a Top 5 Button (if you 
chose CHANGE CHANNEL from a Top 5 Button menu).

Dialog Box Options
Bank Combobox
Choose a bank to for which to list channels.

Channel Combobox
Choose a channel to go to or associate.    Hint: Click on the down arrow to hide or drop the 
listbox portion of the Combobox.    When hidden the UP and DOWN ARROW keys can be 
used to move through the list without blocking the view of channel information displayed 
below.

Button Label (for Top 5 Buttons only)
Choose to change the Top 5 Button Label.



Priority Checkbox
Check this button if you want Radio Manager to check your priority channels regularly.    
Uncheck it to disable priority checking.    Priority channels are those channels associated with
the Top 5 Buttons.    Note: You can also enable priority checking on all, some, or none of the 
Top 5 Buttons.

To change the priority interval click on the this button with the Right mouse button, or 
change the priority interval in the Configuration Dialog Box.

Note: Priorities that are enabled are displayed below the Priority Checkbox.    For example if 
priorities 1,3, and 5 are enabled the numbers "1", "3", and "5" will appear below the 
checkbox.



Priority Interval

How often Radio Manager checks your priority channels.    This should be a number from 1 to
999.    This may not necessarily be the number of seconds, but will be fairly close.    

Tip:    Click on the Priority Checkbox with the Right mouse button to quickly change the 
priority interval.    This method does not save the number each time, so it's quicker.    When 
you've found a number that works for you, use the Configuration Dialog Box to make the 
change permanent.    Several Priority Intervals are listed for you to choose, or you can type in
your own.



Top 5 Buttons
The Top 5 Buttons are like presets on stereos.    You can use them to store you favorite 
channels.    You can even change the label on the button so you can easily recognize which 
buttons are which.    When you want to hear a Top 5 channel simply press the Top 5 Button of
your choice, and Radio Manager quickly switches to manual mode and changes your radio to
the associated frequency.

To change the associated channel click on the button you want to change with the Right 
mouse button.    A pop-up menu appears with options for changing the channel or just the 
button label.    Pick one to customize the button to your needs.    Top 5 Button labels are 
limited to 12 characters.    

Tip: You can use the "&" to specify a hot key for the button.    Place the "&" before the letter 
you want to use for the hot key. You should only use letters that are not already assigned to 
other buttons and controls in the Radio Manager main window.    The letter then appears 
underlined on the button, and you can then press ALT + the underlined letter to choose the 
button.    See the Sample.DB Bank File for an example.

Note:    Now all Top 5 Buttons can be used to store the 5 priority channels that Radio 
Manager checks when you have checked the Priority Checkbox.    If you don't want Radio 
Manager to check a particular Top 5 Button then click on that button with the right mouse 
button and choose Priority from the pop-up menu.    Repeat to enable priority checking for 
that channel.    When the priority is enabled a check mark appears beside the priority menu 
item, and when the priority is disabled the check mark does not appear.

To save the Top 5 Buttons choose Save from the File menu.

See also
Save and Channel Finder Dialog Box



Removing
In the very unlikely event that you don't like Radio Manager and want to remove it from your
computer, or just don't have room for it, you'll need to remove the following files from your 
disk.    To remove the Frequency Manager portion of Radio Manager please see "Removing" in
Frequency Manager Help (FM.HLP).

RM.EXE Radio Manager Program
RM.TXT Radio Manager Description
RM.HLP Radio Manager Help (You're looking at it.)
RM.INI Radio Manager Settings(in your Windows directory)
ICOM.DLL Radio Driver
ICOM.INI Radio Characteristics (in your Windows directory)
PXEngWin.DLL Paradox Engine
BWCC.DLL Additional Program File
CommDlg.DLL Additional Program File
TBPRO1.DLL Additional Program File
TBPRO2.DLL Additional Program File
TBPRO3.DLL Additional Program File
Sample.DB Sample Bank File
Sample.PX Sample Bank File Index
Search.DB Search Ranges File
Search.PX Search Range File Index

Any other files with the extension '.DB', '.PX', 'X02', 'Y03', '.X03', or '.Y03' are data files.    You
may want to keep them if you have entered much data. 



Paradox Bank File Structure
Field #Field Name Field Type
1 Bank N*
2 Channel N*
3 Frequency N*
4 Mode A3
5 Class A20
6 Service A44
7 BankLockOut A1
8 ChannelLockOut A1
9 Delay A1
10 Tone N
11 UseTone N
Field Types
A#: Alphanumeric, Any combination of characters and spaces up to specified width.
N: Numbers with or without decimal digits.
* Indicates the field is part of the primary key.    Please see your Paradox manual for more 
information.

See also
Paradox



Paradox
Paradox is a database management system by Borland International, Inc.    Radio Manager 
uses the Paradox Engine 3.0 (a subset of Paradox) which handles the basic file operations of 
the database.    If you own Paradox you can use it to edit and create Bank Files.

Paradox is a registered trademark of Borland International, Inc.

See also
Paradox Bank File Structure



Registration -- Disclaimer and Agreement
To register please see Order Form

Users of Radio Manager must accept this disclaimer of warranty:
Radio Manager and Frequency Manager are supplied as is.    The author disclaims all 
warranties, expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose. The author assumes no liability for damages, 
direct or consequential, which may result from the use of Radio Manager or Frequency 
Manager.

Radio Manager and Frequency Manager are    "shareware programs" and is provided at no 
charge to the user for evaluation.    Feel free to share it with your friends, but please do not 
give it away altered or as part of another system.    The essence of "user-supported" software
is to provide personal computer users with quality software without high prices, and yet to 
provide incentive for programmers to continue to develop new products.    If you find this 
program useful and find that you are using Radio Manager and Frequency Manager and 
continue to use Radio Manager and Frequency Manager after a reasonable trial period, you 
must make a registration payment of $30.00 (plus shipping, handling, and tax in some 
situations) to Ben Saladino.    The $30.00 registration fee will license one copy for use on any
one computer at any one time.    You must treat this software just like a book.    An example is
that this software may be used by any number of people and may be freely moved from one 
computer location to another, so long as there is no possibility of it being used at one 
location while it's being used at another. Just as a book cannot be read by two different 
persons at the same time. 

Anyone distributing Radio Manager or Frequency Manager for any kind of payment must first
contact Ben Saladino at the address below for authorization. 

You are encouraged to pass a copy of Radio Manager and Frequency Manager along to your 
friends for evaluation.    Please encourage them to register their copy if they find that they 
can use it.    All registered users will receive a copy of the latest versions of Radio Manager 
and Frequency Manager programs.    The current version as of February 6, 1995 is 2.02.      

See also
Order Form

Please, send questions, comments, and suggestions to...

Ben Saladino KC5IRJ
660 W. Oak St.
Hurst, TX    76053-5526 
817-282-0331
CompuServe address 71052,2416
America Online address BSaladino



Ben Saladino KC5IRJ

I'm the guy who programmed Radio Manager.    The program is written in Borland Pascal for 
Windows, and uses the Paradox Engine.    I wrote this help system using Microsoft Word for 
Windows 6.0a and the Microsoft Help Compiler.

I like scanning fire, police, EMS, and military air.    I use an ICOM R-7000, a few Realistic PRO-
2004s, a PRO-2006 with an OptoElectronics OptoScan456™ , a PRO-30, a PRO-34, PRO-43, 
and a Bearcat 950.

Paradox and Borland Pascal are registered trademarks of Borland International, Inc.
Microsoft is a registered trademark of Microsoft Corporation.
OptoScan456 is a trademark of Optoelectronics.



Shareware
Shareware distribution gives users a chance to try software before buying it. If you try a    
Shareware program and continue using it, you are expected to register. Individual programs 
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get anything from the simple right to continue 
using the software to an updated program with printed manual. 

Copyright laws apply to both Shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware. The Shareware 
system makes fitting your needs easier, because you can try before you buy, and because 
the overhead is low, prices are low also. Shareware has the ultimate money-back guarantee 
-- if you don't use the product, you don't pay for it.

See also
Registration



Order Form
Radio Manager 2.02 Copyright © 1993-1995 Ben Saladino
Registration Form (2/6/95-6202) 
Radio Manager includes Frequency Manager.    You'll get the latest version Radio Manager 
and Frequency Manager without the registration reminder screens, and I'll let you know 
about program enhancements and offer them at substantial discounts.    

Registering by Check or Money Order: To register send a check or money order with 
this form to Ben Saladino, 660 W. Oak St. Hurst, TX    76053-5526.    To print this order 
form, click on Print Topic in the File pull-down menu.        Payments must be in US dollars. 

Registering with CompuServe's Software Registration Service: GO SWREG and follow
the menus.    
Radio Manager's registration id is 3602.    The registration fee through CompuServe is $30.00
plus shipping and handling as follows: US $5.30, Canada $6.30, elsewhere $7.30.

Registering with Credit Cards including Master Card, Visa, American Express, and 
Discover.  You can order directly from me as described above, or from Public (Software) 
Library 
(PsL) with your MC, Visa, AmEx, or Discover card by calling 800-242-4PsL (outside the United
States: 713-524-6394), or by FAX to 713-524-6398, or by CompuServe to 71355,470.    These
numbers are for ordering only.    Ben Saladino cannot be reached at those numbers.    To 
contact 
Ben Saladino for information about dealer pricing, volume discounts, site licensing, the 
status of 
shipment of the product, the latest version number, or for technical information, call Ben 
Saladino at 817-282-0331 or write to me at 660 W. Oak St. Hurst, TX    76053-5526.

Radio Manager's registration number at PsL is 10989.    Please specify your preferred disk 
size.

Credit Card Pricing
Registration fee $30.00, Handling Charge in the US $5.00, Handling Charge outside of the US
$7.00.    Texas residents will be charged tax. 

Registration Form for mailing registrations to Ben Saladino
Please check one:              5.25" Disk ____    3.5" Disk ____ Either size ____

Radio Manager single copy: quantity ____ @ $30.00 ea.      =  ____________
Texas residents add 7.75% sales tax                 +  ____________
Shipping is included in the $30.00 for the US and Canada.
(Others add $3.00)  ____________

    Total Payment             ____________

Name:                          _______________________________________________ Mr. Mrs. Ms. Miss Dr.

Company: _______________________________________________

Address: _______________________________________________

City, State, Zip: _______________________________________________



Home Phone #: _______________________________________________

Work Phone #: _______________________________________________

E-Mail address: _______________________________________________

How did you hear about Radio Manager?
_____________________________________________________________

Computer (circle one): 80286 80386 80486 Pentium Speed:_______ MHz

Windows Version: 3.0 3.1

Do you use Paradox? No Yes Version: ________

What radio(s) are you controlling with Radio Manager?

Which other packages have you used to control your radios?    

Comments, Questions, and Suggestions...



Choose

To select an option or item.

Mouse
With the mouse, point and click.

Keyboards
With the keyboard, press ALT and the underlined letter, or use the ARROW keys until the 
item is highlighted and then press ENTER.    Within a dialog box, press TAB to move to or 
select an option.



Scan Mode

Radio Manager switches through the current Bank File's enabled channels until it finds one 
with a signal.    When the signal stops and the delay time has run out or you press the Scan 
Radio Button, Radio Manager continues scanning until it finds another channel with a signal. 
Eventually Radio Manager reaches the end of the Bank File and starts over.    To quit scan 
mode press the Search Radio Button or Manual Radio Button, or simply quit Radio Manager.   
If the Priority Checkbox is checked, Radio Manager interrupts the scanning regularly to check
the priority channels.



Search Mode

Radio Manager starts searching at lower or upper search range limit and increases or 
decrease the frequency until a signal is detected. When the signal stops and the delay time 
has run out or you press the Search Radio Button, Radio Manager continues searching until it
finds another frequency with a signal.    Eventually Radio Manager reaches the upper or 
lower search range limit and starts over.    To quit search mode press the Scan Radio Button 
or Manual Radio Button, or simply quit Radio Manager. 



Manual Mode

Radio Manager patiently waits while you listen to a transmission.    If the Priority Checkbox is 
checked, Radio Manager periodically checks the priority channels for a transmission.    In this
mode you can "hand" enter frequencies and modes into the radio by using the Frequency 
Box,    Frequency Scrollbar, and Mode Box.    You can also turn delays on and off for channels 
(Delay CheckBox), and manually step through channels in the current Bank File (Channel 
Scrollbar).



Frequency Box
When Radio Manager is in Manual Mode you can "hand enter a frequency to your radio.    
Simply type the frequency in the Frequency Box and choose the Enter Button.    If the 
frequency you entered is associated with a channel in the current Bank File, Radio Manager 
displays the channel information for the frequency.    If Radio Manager doesn't find any 
information you may be able to use Frequency Manager to find information on the frequency.
Simply choose the Look Up Button, and Radio Manager searches the last Frequency Manager
file that you used for the frequency.    If it finds any information it is displayed where channel 
information is normally displayed.    Otherwise, Radio Manager displays a message to let you 
know it could not find the frequency.



Mode Box
When Radio Manager is in Manual Mode(mode of operation, not transmission), you can 
change the mode (AM, FMN, FMW, SSB, etc.) that the radio is tuned to. simply choose a 
mode from the list and then choose the Enter Button.    The frequency in the Frequency Box 
and the new mode is sent to the radio.

AM, FMN, and SSB correspond to the AM, FMN, and SSB modes on the Icom R-7000.
FMW in Radio Manager corresponds to the R-7000's FM mode.

The following modes are variations on the above or modes that are not supported by the R-
7000, but are included for those using Radio Manager to control other Icom radios.

Radio Manager Mode Icom Mode
LSB LSB
USB USB
CW CW
FSK RTTY
FM1 FM Passband Width 1
FM3 FM Passband Width 3
FM9 FMW on R-9000



Import (File Menu - Bank Edit Dialog Box)
Opens the Import Dialog Box.



Version History
Sorry, no speed improvements yet.    I don't think it's going to happen with Windows 3.1.    I 
think there's a good chance Windows 95 (96?) will be a better operating system for this type
of program, and I do plan to overhaul Radio Manager to run better in the new Windows.    
There are also some neat programming tools that will be available soon.    They'll make it 
easier for me to add some other features I think you'll like.    Several of you have asked for a 
Spectrum Analyzer feature.    I don't see how this could be done right without hardware, and 
especially in Windows 3.1.    Other programs may offer some sort of spectrum analyzer, but 
without hardware it seems to me that scanning and searching as we've been doing, will be 
more effective for finding new frequencies.    I'm interested to know how useful the other 
programs are in the aspect.

Radio Manager 2.02 (2/1/95)

You can now export Bank Files to text files.    See File Save As

Added 5KHz searching when controlling the OptoScan456™.    See Enable 5khz Search 
Window (OS456 Menu)

Now displays OptoScan456 status Bits.    See Display Status Bits (OS456 Menu)

Edit Frequency Manager Dialog Box enhanced. 

You can now change a channel's Class and Service data in the main window.    See Change 
Description (Edit Menu).

Includes Frequency Manager 1.06 which adds 3 new fields and more.    See Frequency 
Manager Help (FM.HLP) for details.

Finally, by popular request, a printable manual is included in the file RMGUIDE.WRI.    Choose 
the Help|Printable Manual command from Radio Manager to view the file and decide if you 
want the printed manual.    This help file will always be the primary help source.

Radio Manager 2.01 (9/14/94) More OptoScan456™ support and bug fixes

Adds field for PL tone

Adds tone scanning for the OptoScan456™.

Automatically Logs CTCSS and DCS squelch tones to History Window from the 
OptoScan456™.

You don't have to restart Radio Manager for most changes to the Radio Setup Dialog Box.

Bug Fixes
Changed TAB key behavior in the Bank Editor Dialog Box to more standard behavior.

Fixed ENTER key in Bank Editor.    It won't cause the window to close.    It was never supposed
to be that way.

Fixed the delay of displaying dialog and message boxes on slower computers.

Fixed GPF that occurred after renaming a Bank File in the Bank Editor Dialog Box, and 
returning to the main window.



Radio Manager 1.05 (6/27/94)    Enhancements and a few more bug fixes.

Edit Frequency Manager records in Radio Manager
You can now edit Frequency Manager records in Radio Manager without running Frequency 
Manager.

More Fields in Frequency Manager
Frequency Manager has 3 new fields: Last Monitored Date, Brief note, and Rating.

Lock Outs for Searches
You can now lock out frequencies while searching.    It's great for locking out birdies.
See Also Review Search Lock Outs Dialog Box

Easier Bank File Editing
You can now Add and Delete channels more easily without the Bank Editor.

You can now Add banks more easily without the Bank Editor.
See Also    Insert Dialog Box and EDIT DELETE CHANNEL

Faster Search Speed
The search speed has been increased from 10 to 17-18 frequencies per second.

Easier to Customize and Automatic Corrections
Radio Manager can now display the Channels Per Second rate that you are scanning.    This 
makes it easier to adjust Radio Manager's settings for your system.

You can now use the Channel Scroll Bar left and right arrows to change scan direction.

While you can't control more than one radio at a time with Radio Manager, you can set up 
different configuration files for different radios.    For example, if you have a shortwave 
receiver like the R71 and a R7000 you can specify which configuration file to use when you 
start Radio Manager.    See Configuration Dialog Box

Radio Manager automatically corrects search ranges when you reverse the upper and lower 
limits by mistake.

The step size is automatically set to last search step.    See Frequency Scrollbar.

Bug Fixes
Fixed the GPF when the Delay button was selected, and no bank file was loaded.

The first bank with channels is automatically selected when no other banks are selected.

Frequency displayed when iconized and searching.

Finally, "Lock-Ups"    should be fixed.    You should no longer have to press ALT to open 
dialogs.

Fixed Look Up unknowns which wasn't always working.

Switches channels correctly with radios with more than 99 memories.

Radio Manager 2.0 (8/30/94) Adds OptoScan456™ Support.



Now you can control your Pro 2005/6 scanner via the OptoScan456™.

Signal Detection
You can now choose Carrier Detect signal detection, instead of Ring Indicator detection. 
Some people were having trouble with Ring Indicator detection.
You can now choose Software Signal detection if you have an Icom R72, R7100, or R9000.

Signal Strength
If you have an Icom R7100 or R9000 you can now read signal strength from the radio.

Common Setups
If you control more than one king of radio, you can now quickly change radio setups, without
having to type in each setting.    See Radio Setup Dialog Box.

Snooze Lock Out
Now a Right-Click on the Lock Out Checkbox temporarily locks out the channel while you are 
scanning, and unlocks it after a specified time.
Bug Fixes
Hex Addresses should now work, I'm not sure they ever did before.

Priority checking should now return to a previously active non-priority channel.

Radio Manager 1.04 (3/7/94) fixes a few bugs reported by users.

File Save As works where it didnt always before.

Should set 770 Khz and other frequencies below 1MHz on the R-9000. (Thanks Phil)
Please let me know if it works.

Trouble-Shooting Section expanded in help file.

Radio Manager corrects some problems automatically.

Radio Manager 1.03 (7/25/93) fixes a few bugs reported by users, and adds or improves 
the following.

Scan Direction Bug Fixed (Thanks Bob)
Radio Manager now remembers which direction to scan from last session.

History Window Bug Fixed (Thanks Bob)
Partially input frequencies no longer show up in the History Window (i.e. 1, 12, 123, 123.1) 
until you've hit ENTER, and there is activity on the frequency.

History Window Position Saved (Thanks Bob)
Radio Manager now remembers where you positioned the History Window from the last 
session.

Add Trunked Systems Quickly
Radio Manager now lets you quickly enter a trunked radio system that has several 
frequencies that are evenly separated. See Add Trunked System.

Priority Bug in Manual mode Fixed (Thanks Bob)



Radio Manager now returns to the previously active frequency (even if it's not included in 
the current bank file) in manual mode after checking the priority channel(s).

Active Priority Channels Displayed under the Priority Check Box
This makes it quick and easy to see which priorities are enabled.

For SWL folks and those not using    the R-7000 (Thanks Jim and Dan)
Support for passband widths and additional modes has been added (I think), let me know 
how this works for you Jim.    See Mode Box.

Radio Manager now supports more precise tuning to 1Hz.

Radio Manager 1.02 (also known as version Bob <G>) another bug or two reported by 
users, and adds or improves the following.

Multiple Priorities
Now all Top 5 Buttons can be priority channels, and none, some, or all can be checked 
regularly.

Scan in both directions
You can now scan backwards through channels.    See Frequency Scrollbar for details.

Channel Delays
Radio Manager now uses Channel Delays instead of Bank Delays.    This change requires that
previous version Bank Files be updated, but don't worry Radio Manager will detect the older 
files and automatically convert them for you.

Control Menu commands
Now when you run Radio Manager as an icon and work in other programs you can have 
quick access to Radio Manager's primary commands.    See Control Menu Commands.

Search Ranges Saved on Exit
Radio Manager now remembers the search range that you used the last time you ran Radio 
Manager.

Always On Top - Options Menu
Now when the Always On Top menu item is checked Radio Manager will remain on top of 
other windows only when it is minimized.

Radio Manager 1.01 fixes several bugs reported by users, and adds or improves the 
following.

Mode Delay 
If Radio Manager sets the frequency on your radio OK, but not the mode, you can increase 
this setting to make Radio Manager work with your system.    See Configuration Dialog Box

History Window Hits
Radio Manager now includes the number of times that active frequencies are listed in the 
History Window.

History Window Save
Radio Manager can now save most of the information from the HistoryWindow to a text file.   
This information can then be manipulated using other programs for analysis.



History Window Limit 
The upper limit has been increased to 999.    See Configuration Dialog Box

Import
You can now import Frequency Manager files directly to Radio Manager Bank Files. You can 
now import 801-Scan text files directly to Radio Manager Bank Files.

Have any suggestions or bugs?    You're questions, comments, and suggestions will help me 
make the next version even better.    Since this version is fairly new to the OptoScan456, I'm 
sure there will be plenty of suggestions, but don't assume I'll know what you want or that 
someone else will suggest it.    Please let me know.

Ben Saladino
660 West Oak Street
Hurst, TX    76053-5526
817-282-0331
CIS #71052,2416
AOL BSaladino



Import Dialog Box
Use this dialog box to import Frequency Manager frequency lists and 801-Scan files to a 
Radio Manager Bank File.    

Frequency Manager files
Radio Manager will create a bank for each Class in the Frequency Manager file.    Thus if you 
have separate classes in a Frequency Manager file for Fire, Police, and EMS, then Radio 
Manager will create three banks named, Fire, Police, and EMS in the new Bank File.

801-Scan files
To import an 801-Scan file you must have already exported the 801-Scan file to a text file.    
Please see your 801-Scan help for details.    It is not necessary to change anything in the 
exported file.    Radio Manager creates banks for each 801-Scan bank, provided that you 
have not removed the lines that start with "*" in the 801-Scan text file.

File
Shows the file that you've selected to import.

Increments
Bank
Use the spin buttons to increase or decrease the amount to increment bank numbers.

Channel
Use the spin buttons to increase or decrease the amount to increment channel numbers.

Format Radio Buttons
Frequency Manager
Check to import a Frequency Manager file.

801-Scan
Check to import an 801-Scan text file.

File Button
Opens a dialog box to pick a file to import.

OK Button (Disabled until you've selected a file to import)
Choose to import the selected file.

Cancel Button
Choose to close the dialog box without importing any file.

Help Button
You found it.



Import File Open Dialog Box

Use this command to pick a Frequency Manager or 801-Scan file to import to a Radio 
Manager Bank File.

Dialog Box Options
File Name
Type the name of the file you want to open or choose from the list of files.

List Files of Type
Choose the type of file you want to open from the list of file types.    The file types are 
identified by their file name extensions, for example, Radio Manager and Frequency 
Manager files (.DB), text files (.TXT), or All Files (*.*).

Directories
Displays the current directory.    You can choose a different directory.

Drives
Displays the current drive.    You can choose a different drive.



Interface Information
If you're using some of the latest software available    or want to control your Icom radio with 
your computer, you might find this information helpful.    Here's how to modify your Icom CT-
17, or similar computer interface to make it support signal detection.

Signal Detection works by attaching a cable to the Recorder Remote jack on the radio and to
the RS-232 (Com. Port). This additional cable makes it possible for the software to detect 
when there is a signal present on the radio, so that the software can stop scanning, 
searching, or log a hit.

The cable needs a 1/8" mini plug for the radio side.    The other end needs to be connected 
to the RS-232.    One wire needs to be connected to pin 20 (Data Terminal Ready), and the 
second wire needs to be connected to pin 22 (Ring)    or to Pin 8 (Carrier Detect).    Make sure
you choose the proper signal detection method in the Radio Setup Dialog Box. That's all!    

I haven't seen a CT-17, but I know others have performed this enhancement.    I have added 
it to a homemade interface, see below, and an interface that I ordered from J-COM 
Enterprises.    Both modifications were pretty easy to perform, especially considering I had 
not used a soldering iron before building the homemade interface.

If you don't have an interface yet here's information on an inexpensive homemade 
alternative to the Icom CT-17.    I spent about $25 on parts and a few hours building it.    Nigel
Thompson KG7SG wrote the article, "A Low-cost PC Interface for Icom Radios" in QST July 
1992 Page 37 describing the parts and how they go together.    I've added the signal 
detection enhancement above to this one and it works great.    The interface draws its power
from the 
RS-232, so no external power supply is needed.    

The following picture was provided by Ron Harris, who has made the modification to his CT-
17.

DISCLAIMER:
I AM NOT AN ELECTRICAL ENGINEER, BUT AS FAR AS I KNOW THIS MODIFICATION
SHOULD CAUSE NO HARM.    MODIFY AT YOUR OWN RISK.





Control Menu Commands
Most windows whether applications, dialog boxes, or documents, have a control menu.    The 
control menu is always placed at the left end of a window's title bar.    Normally the control 
menu is used only for these commands: Move, Close, Restore, Size, Minimize, Maximize, and
Switch To.    Radio Manager adds the following menus items to its control menu.    You can use
these menu items to control Radio Manager while it is minimized, and you are working in 
another application.

Who is it?
Displays the Class, and Service information for the current channel.

Scan
Works just like the Scan Radio Button.

Search
Works just like the Search Radio Button.

Manual
Works just like the Manual Radio Button.

Lock Out
Works just like the Lock Out Checkbox.

See also
Always On Top



Bank Delay Checkbox
Turns the delay on or off for all channels in the current bank.    This can be helpful when most
or all of the channels in a bank need to have delays enabled or disabled.    You can then 
select the few channels that need the opposite treatment individually.

See also
Delay Checkbox and File Save



OS/2 Notes
I don't have OS/2, but another Radio Manager user has used Radio Manager with OS/2.    He 
did report a problem that you might encounter regarding OS/2 handling of Windows Com 
Ports.    It appears that OS/2 defaults to a virtual setting which will not work for Radio 
Manager.    When switched to the Direct setting Radio Manager worked.    Sorry, I forgot to 
ask him where the setting is located in OS/2.

Thanks again Bob!



Trouble-Shooting
When starting Radio Manager you get the message "Cant share Paradox net file --
is SHARE.EXE loaded?"

If you get a message asking "Is SHARE.EXE loaded?" when you try to run Frequency 
Manager, you'll need to add a line similar to the one below to your CONFIG.SYS file with a 
text editor. You    might need to specify a different directory than the one below depending 
on the location of SHARE.EXE on your system.    SHARE.EXE is included with DOS.    Please 
see your DOS manual for more information on SHARE.EXE.

Install=C:\DOS\SHARE.EXE /L:500 

When starting Radio Manager you get the message Invalid Directory Name

Chances are you are using or have used another program that also uses the Paradox Engine. 
Open your WIN.INI file with your favorite text editor, NOTEPAD.EXE works well, and remove 
the NetNamePath=C:\ line from the [Paradox Engine] section, or comment the line out by 
placing a semicolon (;) in front of the line.    Save WIN.INI and try running Radio Manager 
again.     

Radio Manager or your Mouse "Locks Up" - IRQ Conflicts

The Windows operating environment is great, but unfortunately the PC's architecture is a bit 
limited.    In DOS normally you can only run one program at a time.    In Windows you can run 
several programs at once.    Since more than one program can run at a time, there's a good 
chance two different programs might try to use the same piece of equipment at the same 
time.    In this case a com (serial, RS-232) port.    Even though you may have 4 com ports, 
you probably can't use all four at once (There are some systems that allow this).    The 
reason is the limited number of IRQ (Interrupt Request) lines of the PC.    Because there are 
so few, com ports 1 and 3 usually share an IRQ, and com ports 2 and 4 usually share 
another.    So as long as you don't try use devices on com 1 and 3 (or com 2 and 4) at the 
same time you'll be OK.    There are some solutions to the problem. First you can rearrange 
your devices so you don't have the conflict. For example, my PC has this set up.    Com 
1:Mouse, Com2:Radio, Com3:Label Printer, Com4:MODEM.    Since I don't (can't) use my 
radio and MODEM at the same time there's no conflict.    When I use the label printer my 
mouse dies, but comes back after closing the label printer program (luckily I don't use it 
often and for long).    The other option is to buy one of the new com port cards that has a 
larger selection of IRQs (check your cards, may be you can change the IRQs).    If you change
IRQs on a com port, make sure you tell Windows about it.    Go to Control Panel and choose 
the Ports icon, choose the appropriate com port, and then the Settings and Advanced 
buttons.    The IRQ selected there must match the IRQ the hardware is set to (usually by 
jumpers or DIP switches on the card).      I know it's a pain.    Hopefully the Plug-In-Play will 
solve the problem on your next PC.

Radio Manager Locks up

If Radio Manager doesn't seem to respond to commands, such as choosing Help|About, then 
you may need to decrease the sample factor and increase the speed factor.

Radio Manager switches frequencies, but not modes.

If Radio Manager is switching frequencies OK, but won't change modes on the radio then you
might need to increase the Mode Delay.



Radio Manager wont write or read channels to and from the radio.

Radio Manager is running ahead of the radio and its interface, so a delay is needed on faster
computers to correct the problem.    Please see Read & Write Delays.    The delays have been 
modified in version 1.04, and should work when previous versions did not.

Radio Manager won't log hits in the History Window.
Try increasing the speed factor and the sample factor.

Radio Manager won't stop on active frequencies.
Check your cabling.    Loose wires, especially inside the OptoScan456™ can cause this 
problem.    Also make sure you've read the section Signal Detection.

See Also
OS/2 Notes



Edit Frequency Manager Record Dialog Box 
Use this dialog box to edit Frequency Manager records from Radio Manager.

This makes it easier to update your frequency list as you listen.    When you choose the EDIT|
EDIT FREQUENCY MANAGER RECORD menu item.    Radio Manager finds the frequency 
displayed in the last Frequency Manager file that you used.    If it doesn't find the frequency, 
you can complete the information and choose the Add button to add it to the list.

Buttons
Next
If there's more than one record for a frequency you can use this button to cycle through 
the records.

New
Clears the dialog, so that you can type in information on a new frequency.    Choose the 
Add button to save the new record.

Delete
You guessed it.    Choose this button, and the record is deleted from the frequency list.

Add 
After completing the information choose this button to save a new record.
or
Update
After editing the information choose this button to save the changes.

Add and Close
Same as the Add button plus it closes this dialog box.
or
Update and Close
Same as the Update button plus it closes this dialog box.

Cancel
Closes the dialog box without save changes to the record.

Help
You're looking at it.



Insert (Edit Menu)
Opens the Insert Dialog Box which is used to quickly add channels to the current Bank File.

This is a quicker way to add a few channels to a bank file than the Bank File Dialog Box.



Delete Channel (Edit Menu)
Deletes the currently selected channel from the Bank File.

This is a quicker way to delete a few channels from a bank file than the Bank File Dialog Box.



Change Description (Edit Menu)
Opens the Change Description dialog box, so you can quickly change the Class and Service 
fields for the current channel.



Insert Dialog Box
Use this dialog box to quickly add channels to the current Bank File.

Simply choose a bank from the Bank drop-down list box to add the channel to, or choose 
"***New Bank...***" to add a new bank.      Then fill in the Channel number, Frequency, Mode,
Class, and Service, or if you're adding a new bank, type in a bank number and name, and 
choose the Add button.    You can then add another channel or bank, or choose Close or 
Cancel to stop adding new channels.

See Also
Bank File Dialog Box



Review Search Lock Outs Dialog Box
Use this dialog box to see which frequencies are not included when searching.

Mouse
Click on a frequency to select it.

Double-Click on a frequency to listen to it.

Buttons
Unlock Out
Removes the selected frequency from the Lock Out list.

Unlock Out All
Removes all frequencies from the Lock Out list.

Save
Saves the current Lock Out list to disk.    Radio Manager will use the list in future sessions.

See Also
Searching



Show Channels/Second (Options Menu)
When checked shows the channels per second that Radio Manager is scanning or searching 
in the status line.    If a signal is present, the reading will be 0.    If you turn off your radio, 
you'll get an idea of how fast Radio Manager is scanning.    You can use this when trying 
different Speed Factors and Sample Factors that are set using the Configuration Dialog Box 
and the Radio Setup Dialog Box.



"S" - Signal Strength Button
Only available on some radios, including the R7100,    R9000, and OptoScan456™.

Displays the signal strength if available on the Status Line.    This is the same command as 
the OS456|Read Signal Strength command.



Speaker (OS456 Menu)
This command is only valid for the OptoScan456™.

When checked turns on the Pro 2005/6's speaker.

When unchecked mutes the Pro 2005/6's speaker.



Read DTMF Digits (OS456 Menu)
This command is only valid for the OptoScan456™.

Displays the most recently decoded DTMF digits by the OptoScan456™, up to 31 digits.

DTMF digits are used to dial phone numbers and to access special radio features.



Read DCS Tone (OS456 Menu)
This command is only valid for the OptoScan456™.

Displays the most recently decoded DCS tone by the OptoScan456™.    If there is a 
transmission currently using a DCS tone, Radio Manager will display the tone followed by 
"Active", or "Last Detected Inactive", if the tone is from a previous transmission.

See Also
Squelch Tones



Read CTCSS Tone (OS456 Menu)
This command is only valid for the OptoScan456™.

Displays the most recently decoded CTCSS tone by the OptoScan456™.    If there is a 
transmission currently using a CTCSS tone, Radio Manager will display the tone followed by 
"Active", or "Last Detected Inactive", if the tone is from a previous transmission.

See Also
Squelch Tones



Read Signal Strength (OS456 Menu)
This command is only valid for the OptoScan456™.

Displays the signal strength in the Status display.

For the OptoScan456™ the signal strength is reported in units of absolute dBm as measured 
at the antenna connector.    The highest possible signal is 0 dBm, and the lowest is -125 
dBm.



Tape Recorder (OS456 Menu)
This command is only valid for the OptoScan456™ while the Computer Control menu item is 
checked.

When checked enables the tape recorder attached to the Tape Pause output on the 
OptoScan456™.

When unchecked disables the tape recorder attached to the Tape Pause output on the 
OptoScan456™.



Computer Control (OS456 Menu)
This command is only valid for the OptoScan456™.

When checked turns on computer control of the OptoScan456™.

When unchecked turns of computer control of the OptoScan456™.

Normally you won't change this because Radio Manager will be doing all of the work for you. 
However, there might times when you want to enter frequencies directly to your Pro 2005/6, 
or scan and search directly with it.    When the radio stops on a signal Radio Manager can tell
you more about the signal like whether or not it's using squelch tones, its strength, or if 
there is DTMF activity.



OptoScan456
The OptoScan456™ is a computer interface for the Radio Shack Pro 2005 and Pro 2006 
scanners.    Besides controlling the radio it decodes CTCSS and DCS Squelch Tones, decodes 
DTMF digits, reports signal strength, and just makes using the Pro 2006 easier with Radio 
Manager for Windows, you'll gain more flexible channel banks, search ranges, multiple 
priorities, user definable delays, and more.

If you don't already have one, contact the manufacturers of the OptoScan456™.

OPTOELECTRONICS
5821 N. E. 14th Avenue

Fort Lauderdale, FL    33334
1-800-327-5912

OptoScan456™ is a trademark of Optoelectronics.



Squelch Tones
Squelch Tones are used to restrict access to repeaters and where two or more groups of 
radio users are using the same frequency, but don't want to hear the other group(s) radio 
traffic.    Radio Manager automatically logs active tones to the History Window.    

See Also
OptoScan456™



Tone Box
This field is only visible when in manual mode, and if you are controlling the OptoScan456™. 

The Tone Box is actually two boxes.    The box on the left holds the tone that you want a 
particular channel to have.    The portion on the right determines if the tone is used while 
scanning, and whether it's a DCS or CTCSS tone.

If you choose "None" in the right box Radio Manager scans as usual.

If you choose "CTCSS" or "DCS", Radio Manager will continue scanning unless the signal on 
the frequency has a matching and active tone to the one you have entered in the left box.    

Currently Radio Manager's tone scanning is a bit different from what you probably expect.    
The speaker is never muted.    You will hear anything that is on the frequency until Radio 
Manager determines if the there is a matching tone.    If it matches you'll continue to hear 
the signal until it and any delay is over.    If it doesn't match, Radio Manager will continue on 
to the next frequency. I realize this isn't what most people want, but it's the best I've been 
able to come up with so far.    The OptoScan456™    requires several commands to implement
tone scanning.    Unfortunately there's too much communication between the OptoScan456 
and Radio Manager for Windows to do this much better now.    I'll keep working on it though, 
and I've suggested to Optoelectronics that more of the work be done by the OptoScan456™ 
in any future versions of it, and any future interfaces they might develop.    They seemed 
very receptive and said they have already considered.

See Also
Squelch Tones



Enable 5KHz Search Window (OS456 Menu)

When checked enables the OptoScan456™ to use a more precise tuning step which may 
reduce interference from adjacent frequencies.    Radio Manager automatically checks this 
option if you have a 5KHz search step selected.



Display Status Bits (OS456 Menu)
Reads status bits from the OptoScan456™ and displays them in the OptoScan456 Status 
dialog box.



OptoScan456 Status Dialog Box
This dialog box shows the OptoScan456's™ status bits.    The information is for display only, 
and checking the boxes does not affect the actual status of the OptoScan456™.    The 
information is provided for trouble-shooting and fun only.    The information is not updated 
automatically.    You must choose the Redisplay button to check the status again.

Status Bits
Remote Control
Checked when under computer control

DTMF Digits Pending
Checked when there are DTMF digits that have not been read

DTMF Buffer Overun
Checked when there are DTMF digits that were lost.    The buffer holds up to 31 digits.

Squelch Open
Checked when a signal is detected

CTCSS Tone Active
Checked when a tone is in use

DCS Code Active
Checked when a code is in use

Tape Enabled
Checked when the tape jack is enabled

Speaker Enabled
Checked when the speaker is not muted

5KHz    Search Enabled
Checked when the 5KHz search window is enabled

Audio Present
Checked when there is audio present and the    Sound Squelch on the radio is on.
Checked when the Sound Squelch on the radio is off.

The current Frequency and Mode should also be displayed below the status bits.



Back Ups
There are some Radio Manager files that you should back up occasionally.    Any files in your 
RM directory with the .DB and .PX extensions are data files, and should be backed up.    Also 
RM.INI and ICOM.INI located in your Windows directory should be backed up.    They contain 
configuration settings that Radio Manager reads during start up.    Also back up any other 
files that are referenced in your Frequency Manager frequency lists.    These might be text 
and bitmap files that you have named in the Note and Aux. File fields.

See Also
Frequency Manager Help (FM.HLP)



Printable Manual (Help menu)
Opens the Windows WRITE.EXE program with the file RMGUIDE.WRI.    You can then print the 
file if you decide you want a printed manual.    This help file will always be the primary help 
source, but enough of you asked for a printed manual, so here it is.




